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WARRANTY

For a period of one year from its date of purchase new and undamaged from Polar
Instruments Ltd, POLAR INSTRUMENTS LTD or its authorized distributors will,
without charge, repair or replace at its option, this product if found to be defective in
materials or workmanship, and if returned to POLAR INSTRUMENTS LTD or its
authorized distributors transport prepaid. This warranty is expressly conditioned
upon the product having been used only in normal usage and service in accordance
with instructions of POLAR INSTRUMENTS LTD and not having been altered in any
way or subject to misuse, negligence or damage, and not having been repaired or
attempted to be repaired by any other than POLAR INSTRUMENTS LTD or its
authorized distributors. EXCEPT FOR THE FOREGOING EXPRESS WARRANTY
OF REPAIR O R  REPLACEMENT POLAR INSTRUMENTS LTD MAKES N O
WARRANTY OF ANY KIND, INCLUDING BUT NOT LIMITED TO, ANY EXPRESS
OR IMPLIED WARRANTY OF MERCHANTABILITY OR FITNESS FOR ANY
PARTICULAR PURPOSE, AND POLAR INSTRUMENTS LTD SHALL NOT BE
LIABLE FOR ANY DAMAGES, WHETHER DIRECT OR NOT OR OTHERWISE,
BEYOND REPAIR OR REPLACING THIS PRODUCT.

Copyright Polar Instruments Ltd. ©1995

Microsoft, Windows and MS-DOS are registered trademarks of Microsoft Corporation.

IBM is the registered trademark of International Business Machines Corporation.
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DECLARATIONS

EUROPEAN COMMUNITY DIRECTIVE CONFORMANCE STATEMENT

This product conforms to all applicable EC Council Directives, including:

EC Council Directive 89/336/EEC on the approximation of the laws of the Member States
relating to electromagnetic compatibility.

EC Council Directive 73/23/EEC on the harmonisation of the laws of the Member States
relating to electrical equipment designed for use within certain voltage limits.•

•

A declaration of conformity with the requirements of these Directives has been signed by:

POLAR INSTRUMENTS (UK) LTD
11 College Place
London Road
Southampton
England
SO1 2FE

Harmonised standards applied in order to verify compliance with these Directives:

EN 50081-1:1992
EN 50082-1:1992
EN 61010-1:1993
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SAFETY
WARNING
The LIVE and NEUTRAL lines on this unit are BOTH fused.

This unit contains no user-serviceable parts. When the unit is connected to its supply, the opening of
covers or removal of panels is likely to expose dangerous voltages. To maintain operator safety, do
not operate the unit unless the enclosure is complete and securely assembled.

GROUNDING
This unit must be earthed (grounded); do not operate the instrument with the safety earth
disconnected. Ensure the instrument is connected to an outlet with an effective protective conductor
terminal (earth). Do not negate this protective action by using an extension cord without a protective
conductor.

Note: This instrument is fitted with 3-wire grounding type plug designed to fit only into a
grounding type power outlet. I f  a special local plug must be fitted to the power cord ensure
this operation is performed by a skilled electronics technician and that the protective ground
connection is maintained. The plug that is cut off from the power cord must be safely
disposed of.

Power cord color codes are as follows:

Europe

brown l i v e
blue n e u t r a l
green/yellow e a r t h  (ground)

United States

black l i v e
white n e u t r a l
green g r o u n d

•

•
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POWER SUPPLY
Check that the indicated line voltage setting corresponds with the local mains power supply. See the
rear panel for line voltage settings.

To change the line voltage settings refer the instrument to a skilled electronics technician. Instructions
for changing the line voltage settings are contained in the CITS Service Manual published by Polar
Instruments.

CITS for WINDOWS OPERATION

This manual contains instructions and warnings which must be observed by the user
to ensure safe operation. Operating this instrument in ways other than detailed in this
manual may impair the protection provided by the instrument and may result in the
instrument becoming unsafe. Retain these instructions for later use.

The unit is designed for use indoors in an electrical workshop environment at a stable work station
comprising a bench or similar work surface. Use only the accessories (e.g. test probes and clips)
provided by Polar Instruments. The unit must be maintained and repaired by a skilled electronics
technician in accordance with the manufacturer's instructions.
If it is likely that the protection has been impaired the instrument must be made inoperative, secured
against unintended operation and referred to qualified service personnel. Protection may be impaired
if, for example, the instrument:

• Shows signs of physical damage
• Fai ls to operate normally when the operating instructions are followed
• H a s  been stored for prolonged periods under unfavourable conditions
• H a s  been subjected to excessive transport stresses
• H a s  been exposed to rain or water or been subject to liquid spills

CAUTION

Electrical Isolation
Always disconnect the board under test from the local mains supply (including ground) before using
this instrument. The CITS applies test voltages to the item under test. Make sure that the item under
test is isolated from all other sources of electrical power. External power could damage the tester.

Static Sensitive Devices
This unit contains Static Sensitive Devices. Observe static precautions at all times.

i i i
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SPECIFICATIONS
Test parameters

Controlled Impedance Measurement Range

Impedance Tolerance Range

Measurement Accuracy

Vertical Display Ranges

Horizontal Display Ranges

Testable Trace Lengths
Maximum
Minimum (using non-matched probe)
Minimum (using matched probe)

Horizontal Distance Units

Test Method

Reflected Pulse Risetime

System Bandwidth

Output Impedance

Pulse Amplitude

Calibration Method

Series Loop Compensation

Vp Compensation

0 — 50052

1 — 100%

1% at 50Q

1, 2, 5, 10, 20, 5052/division

Automatically set by software

15 meters
0.09 meters
0.04 meters

Inches, feet, meters, millimeters

Time Domain Reflectometer
(TDR measurement using PC software
control)

200ps

1.75 GHz (derived from maximum risetime)

5052 (± 2%)

Nominal 300mV into 5052 load

Ratiometric measurement to calibrated
precision internal 5052 reference

0 — 1552/meter

(inches)

(meters,
millimeters, feet)

0.33 — 0.82

0.33 — 0.99

•

•

•
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Altitude Up to 2000m
Temperature +5°C to +40°C ambient
Relative humidity RH 80% maximum at 31°C — derate linearly to

50% at 40°C
Mains borne transients As defined by Installation Category II

(Overvoltage Category II) in IEC664
Pollution Degree 2 (IEC664)

•
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ENVIRONMENTAL OPERATING CONDITIONS
The instrument is designed for indoor use only under the following environmental conditions:

Power Requirements
230V ± 10%, 115V ± 10% or 100V ± 10% at 50/60Hz, 20VA.

Physical characteristics (excluding accessories)
Temperature

Operating 1 0 ° C  to 30°C
Storage 0 ° C  to +50°C

Dimensions 443 mm (17.44 in.) wide
114 mm (4.48 in.) high
280 mm (11.02 in.) deep

Weight 5 . 0 k g  (11 lb.)

SYMBOLS

A C A U T I O N

A
L t▶  CAUTION

No external voltage should be applied to these terminals.

Static sensitive devices — observe static precautions. A wriststrap is provided
with the CITS (connect the wriststrap to the stud on the CITS rear panel).

Note: The CITS contains static sensitive devices —
observe static precautions at all times.
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PERSONAL COMPUTER REQUIREMENTS

Computer
Processor
Operating system

System memory required
Hard disk space required
Video standard
Diskette drive
Mouse
Printer port
Communication ports

ACCESSORIES

Standard Accessories
Probe Cable (x 2 for CITS200)
IP-50 Microstrip Probe (50Q)
IPD100 Differential Probe
Verification Test Coupon
Operator manual
RS-232 interface cable ACC142
Foot Switch
Antistatic wristband
Wristband ground cord ACC176
Manufacturing data files diskette

Optional Accessories
Instrument carrying case (ACC125)
IP-75 Microstrip Probe (7552)
IP-100 Microstrip Probe (10052)
Coupon Holder
CITS Service Manual

IBM PC AT or compatible
80386 or better
MS-DOS 3.3 or later
Microsoft Windows ® 3.1 or later running in
386 Enhanced Mode
4Mb
1Mb
VGA (640 x 480 min.)
3% High density — 1.44Mbyte
Microsoft compatible
1 x parallel printer port
1 available serial communication port required

WMA258

MPCD950
MAN 152

ACC124
ACC175

FSW148

ACC125

ACC153
MAN143

•

•
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GUIDE TO THE MANUAL
Note: Except where noted this manual applies to both CITS100 and CITS200.

INTRODUCTION An overview of the Polar CITS100 and CITS200.
A description of the principles of operation and connector and rear
panels

INSTALLATION/SET UP C o n n e c t i n g  the instrument to a power supply, installation of
software and preparation for use.

Specifying the instrument type, PC communication ports,
calibration type and passwords.

GETTING STARTED I n t r o d u c t i o n  to basic CITS operation using the supplied Verification
Test Coupon.

OPERATION O p e r a t i o n  of the CITS100 and CITS200. Information about the
different ways in which the facilities of the CITS100 and CITS200
can be used and how to test boards.

THE TEST FILE EDITOR D e s c r i p t i o n  of test parameters — creating, writing and saving test
files.

MAINTENANCE D e t a i l s  of maintenance and cleaning procedures.

APPENDIX A N o t e s  on Characteristic Impedance.

APPENDIX B N o t e s  on static sensitive devices and preventing damage to the
CITS.

vii
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Operating the CITS100 and CITS200
The CITS software is designed for use within the Microsoft Windows environment. Familiarity with the
Microsoft Windows environment (3.1 or later) is assumed.

For more information on basic Microsoft Windows operation consult the Microsoft Windows User
Guide.

CITS100 and CITS200 functions are controlled by selecting the associated commands from pull-down
menus or clicking the "short-cut" buttons with the mouse.

Selecting a command:

using the keyboard:
• act ivate the CITS menu bar by pressing the Alt key on the keyboard
• p r e s s  the underlined letter in the menu name to display the command list
• p r e s s  the underlined letter in the command name.

using the mouse:
• t o  display a command list, point to the menu name and click the left mouse button
• p o i n t  to the command name and click the left mouse button

Selecting a command name which is followed by ellipses (...) displays a dialog box containing options
which qualify the command.

Clicking the OK button corresponds to pressing the <Enter> key on the keyboard.

Clicking the Cancel button corresponds to pressing the <Esc> key on the keyboard.

On-line help
The CITS software incorporates comprehensive on-line operating information. The Help command
offers a rapid and convenient way to find information, such as how to perform tasks. Press the <F1>
key to access the Help file.

•

•

•
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SECTION 1 INTRODUCTION

INTRODUCTION TO CONTROLLED IMPEDANCE TESTING
The CITS100 and CITS200 Controlled Impedance Test Systems are designed to provide low cost
automated measurements of the characteristic impedance of printed circuit boards.

•

•

M i c r o s t r i p
P r o b e

IBM P C  A T  o r  c o m p a t i b l e

C I T S 2 0 0  C o n t r o l l e d  I m p e d a n c e  T e s t  S y s t e m

F o o t  S w i t c h

T e s t  c o u p o n

P r i n t e r  f o r  h a r d  c o p y

Figure 1-1 The CITS Controlled Impedance Test System

M o u s e

As shown in the diagram above the Controlled Impedance Test System comprises a measurement
system controlled by software running within the Microsoft Windows environment on an IBM PC AT or
compatible.

Connection between the CITS and boards under test is achieved using probe cables and Microstrip
probes.

1-1
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1-1 T h e  CITS software
The CITS100 and CITS200 instruments are designed to facilitate rapid and convenient testing of
controlled impedance printed circuit boards.

The CITS software is written to run within the Microsoft Windows environment so test result waveforms
may be printed out using the currently installed printer.

The CITS system may be controlled from the PC keyboard or by simple point-and-click operations with a
Microsoft-compatible mouse. Use of a mouse is recommended for maximum ease of use.

A plug-in foot-switch is included with the CITS to allow the operator to perform hands-off testing.

The CITS200 incorporates facilities for differential impedance measurements.

1-2 T e s t  files
All the information necessary for performing a controlled impedance measurement on a circuit board is
stored in a test file. An operator only needs to select the appropriate test file from a list and the system is
ready for testing.

Test files are easily created and modified using the integrated test file editor — most files will be created
with just a few key strokes and mouse clicks.

Sequences of a number of test files may be generated by creating a macro file to provide for automated
testing of boards with a number of different controlled impedance traces.

1-3 D a t a  analysis
Test results are displayed as a graph of impedance against distance along a PCB track and a PASS or
FAIL result is reported according to whether or not the trace remains within tolerance over the full length
of the tested region. The average, standard deviation, minimum and maximum impedance values over the
tested region are displayed on screen along with the waveform.

All test results are displayed on the PC screen in waveform and statistical form for rapid analysis.
Waveforms may also be stored to disk for later inspection.

Test data may be logged for subsequent statistical analysis. The stored data may be printed out or
imported into a spreadsheet.

1-2
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1-4 C I T S  features
The CITS100 and CITS200 systems include the following features:

• Automatic instrument setup
• L i nea r  display of impedance against distance
• Differential impedance measurement facility (CITS200 only)
• R a p i d  data logging of test results
• Microsoft  Windows environment
• M o u s e  driven user interface for ease of use
• Pass/Fail  testing of PCB tracks
• D i s k  storage of test results
• H a r d  copy of test & stored results
• Statistical analysis for process control
• Integrated test file editing
• Comprehensive on-line help
• Waveform overlay for rapid comparison of results
• Dedicated Microstrip probes for easy connection to the board under test

1-3
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1-5 Characteristic impedance
As the speed of electronic devices increases the electrical properties of the circuits carrying signals
between them become more important.

At the high frequencies and clock rates of modern digital circuitry, cables and PCB tracks increasingly
need to be considered as transmission lines.

In the case of PCB tracks the series resistance and parallel conductance of the transmission lines are
largely negligible. The most significant circuit parameters governing performance are the distributed
series inductance and parallel capacitance of the conductors.

These parameters give rise to the characteristic impedance Z0.

z 0 = ..r_
where L is in henrys per unit length, C is in farads per unit length and Z. in ohms.

Consider an electrical signal travelling through a conductor such as a PCB track.

When the signal encounters a change of impedance, i.e. Z .  arising from a change in material or
geometry, part of the signal will be reflected and part transmitted.

These reflections are likely to cause aberrations on the signal which may degrade circuit performance.

To optimise performance of high speed circuits it is desirable to match the input and output impedances of
devices with the characteristic impedance of the interconnections.

See Appendix A for a more detailed discussion of characteristic impedance.

•

•

1-4



INTRODUCTION

1-6 T D R  fundamentals
The CITS100 and CITS200 Controlled Impedance Test Systems make measurements using Time
Domain Reflectometry (TDR).

Time Domain Reflectometry
A Time Domain Reflectometer is a special kind of oscilloscope.

A "normal" oscilloscope measures changes in voltage over a period of time and displays this as a graph.
A TDR performs a similar function but incorporates additional circuitry to output a voltage and monitor
changes in that voltage level over a period of time.

Time domain reflectometry is similar in principle to radar or sonar in that a signal is transmitted and the
reflections or echoes of that signal monitored.
In the case of TDR the signal is a voltage transmitted along a cable or PCB track.

Reflections of the signal occur when there is a change in the characteristic impedance of the conductor.
The time taken for the reflections to return to the TDR can be used to measure the distance to any
change in impedance.

TDR

Zol Z o 2

Cable PCB Track

Output voltage
step

Reflection from
first impedance
change

1

First impedance E n d  of track
change

Reflection from
open circuit at
end of track

Transmitted
Signal

Figure 1-3 Simplified TDR-cable system equivalent circuit
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The diagram below shows a typical TDR waveform.

Zero voltage
Step Output

3 foot 50 ohm cable
2 foot 75 ohm cable

Open Circuit

Figure 1-4 1-4 TDR trace showing voltage steps at impedance discontinuities

As the step wave propagates down the cables any increase in characteristic impedance causes a
reflected voltage which adds to the initial step.

This is shown, for example, in the diagram above by the step up from the 500 to 7552 cable.

A decrease in impedance would cause a reflection in the opposite sense which would show as a
downward step in the TDR trace. As long as the characteristic impedance remains constant the trace
remains level.

The open circuit at the end of the cable reflects 100% of the voltage in a large upward step.

If the end of the cable were to be short circuited a 100% reflection in the opposite direction would occur,
returning the trace to the zero voltage level.

•
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1-7 C I T S  measurements
The CITS displays a graph of the characteristic impedance of a specified length of PCB trace.

This is achieved by calculating the impedance along the length of the cable or PCB based on the size of
the reflections measured using time domain reflectometry.

Single ended impedance testing
Normal controlled impedance structures comprise a single signal conductor and a ground plane or
planes. Impedance measurements made between the signal and ground are sometimes referred to as
single ended.

Differential impedance testing
A more complex type of controlled impedance structure is that of a differential pair of signal conductors.
The lines are driven as a pair with one line transmitting a waveform of the opposite polarity to the other. At
the receiving end one signal is subtracted from the other so noise induced in both lines is cancelled out.
This method is commonly employed to achieve high noise immunity in high speed digital and analog
systems.

The characteristic impedance of a differential pair is affected not only by the impedance of each line of the
pair to ground but also by the interaction of the signal lines with each other.

The CITS200 includes all the features and measurement facilities of the CITS100 as well as the facility to
make differential impedance measurements in which the impedance between conductors is tested as well
as the impedance between conductors and ground.

1-7
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SECTION 2 INSTALLATION AND SET UP

SETTING UP THE CITS SYSTEM

System requirements
The CITS software is designed to run on a personal computer meeting the following specifications:

•

•

•

Computer
Processor
Operating system

System memory required
Hard disk space required
Video standard
Diskette drive
Mouse
Printer port
Serial Communication ports

IBM PC AT or compatible
80386 or better
PC-DOS/MS-DOS version 3.3 or later
Microsoft Windows 3.1 or later
4MB
1MB
VGA (640 x 480 minimum)
31/2" High density 1.44MB
Microsoft compatible
1 x parallel printer port
1 x available serial communication port required

2-1 Unpacking
The instrument is shipped in a sturdy transit pack. Open the pack carefully and remove the instrument
and its accessories. If the instrument is damaged in any way contact the local distributor or supplier.

Retain the pack for possible future use.

The package should contain:

CITS100/200
Probe cable (2 probe cables for CITS200)
IP50 Microstrip probe (2 IP50 Microstrip probes for CITS200)
Verification test coupon
Power cord
RS 232 interface cable
Foot pedal
Accessory pouch
Operator manual
Program installation diskette

Note: If the instrument has been shipped or stored in a cold environment, allow the instrument to reach
the temperature of its new location before applying power.

2-2 Connecting to a power supply

Refer to the voltage label on the rear panel of the instrument and make sure that the marked
rating is suitable for the local mains power supply.

2-1



CITS FOR WINDOWS OPERATOR MANUAL

If the rating on the label is not suitable for the local power supply refer the instrument to a skilled
electronics technician. Instructions for changing the line voltage settings are contained in the T1000A
Service Manual.

Note: If a special local plug must be fitted to the power cord ensure this operation is performed by a
skilled electronics technician and that the protective ground connection is maintained. The plug that is cut
off from the power cord must be safely disposed of.

Power cord color codes are as follows:

Europe

brown l i v e
blue n e u t r a l
green/yellow e a r t h  (ground)

United States

black l i v e
white n e u t r a l
green g r o u n d

Connect the power cord to the instrument and to the power source.

•

•

•
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INSTALLATION AND SET UP

2-3 Installing the CITS software

Users are recommended to make working copies of the CITS installation
diskettes before installation and store the master diskettes in a safe place.

Backing up the installation diskettes

Use the PC/MS-DOS diskcopy or the Windows File Manager Copy Disk... command to make working
copies of the installation diskettes. See the PC/MS-DOS operating system manual or the Microsoft
Windows User Guide for details.

• I f  Microsoft Windows is not already running start Windows by typing WIN at the C:\> prompt.

• I nse r t  the working diskette in the diskette drive. From the Program Manager's or File
Manager's File menu select Run..., type A:Install and press <Enter>. (Drive A: is assumed
— if the drive letter is not A: supply the appropriate drive letter, e.g. drive B:, and press
<Enter>.)

• T h e  CITS Installation program proposes the drive and directory of the hard disk onto which
the CITS program is to be installed (by default c:\wincits).

Polar CITS - Installation

This program will attempt to create
fallowing directory en your drive an
up Polar CITS_
If you want to install kin a different
directory and/or drive, type or select the
path below.

r

Polar CITS requires 11;13 Kb of hee
4:ipaceuen the k1ve.

rccorrtinue

Elkin:6%e'; I

Press <Continue> to accept the proposed destination drive and directory or type the name
of an alternative drive and directory.
To choose an existing drive and directory press the Choose Directory button:

L i the Choose Directory button

Select the destination directory from the Directory box and press OK
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Press <Continue>.

• T h e  Installation program will prompt for a name for the CITS program group. The CITS
program icons will be created in the specified program group.

Polar CITS - Installation

Press <Enter> to accept the proposed name, or type in a different name in the name box or
select an existing group (press the drop-down list box arrow to display the current group list).

• T h e  Installation program will prompt for the CITS instrument type (CITS100 or CITS200) —
click on the appropriate instrument type and click on <Next>
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Select your CITS Instrument
type_

CITS type[

0  Cits 100
0  Cits 200

Step 1 of 4

• T h e  Installation program will next prompt for the Reference Impedance of the CITS. This is
recorded on a label on the rear panel of the instrument.

Reference Impedance: 50.0
Enter Reference Impedance-

Ohm: T h i s  can be found on the rear
panel of your CITS system

Step 2 of 4

ext >1

• T h i s  value is unique to each CITS — enter the value exactly as shown on the rear panel of the
instrument.

• I f  no instrument is available at the time the software is installed, enter the default value 50.00.
If an instrument is later connected to the PC use System Config (Options menu) to enter its
Reference Impedance. Press <Next>.

• T h e  Installation program will next prompt for the host computer's Serial Communications Port
to be used when transferring commands and data — select the appropriate port and press
<Next> to confirm and proceed with installation.
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- Com Port —

o  Corn 1
0  Corn 2
O  Corn 3
O  Corn 4

Step 3 of 4

Com Port - Select the COM
Port that your CITS system will N r s x t
be connected to.

• T h e  Installation program will next prompt for the Waveform Source.

< EleViOUs

- Waveform Source

0  Simulated
CITS

Select 'Simulated' if you have
no CITS available for
waveform capture. Test
waveforms will then be
simulated.

Step 4 of 4

The CITS software may be operated in either CITS mode (the normal operating mode) or
Simulated mode for use when no instrument is connected (in Simulated mode the software
simulates the operation of a CITS instrument). Select the desired option and press Finish.

• ( I f  any of the values are incorrect or need to be changed, press the Previous key to step
back through the installation and repeat the installation steps as necessary.)

• T h e  installation program will create the CITS directory and file structure, copy the CITS files
onto the hard disk and create a program group and the CITS program item.

Hint: The CITS program may be started each time Windows is started — hold the <Ctrl> key
depressed and drag the CITS icon with the mouse to copy the CITS program to the Startup group.

•

•

•

•
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2-4 Connecting the computer to the CITS
CITS commands and data are transferred between the CITS and the host computer via a serial
communication (RS 232) link using the supplied cable.

Ensure the host computer and the CITS are both powered down before connecting cables.

Connect the cable between the host computer's serial port and the connector on the rear of the CITS.
Ensure the connections are secure.

If a serial mouse is connected to the PC, the mouse will normally be connected to the host computer's
serial port COM1 or COM2 — connect the CITS serial cable to an available port (using a 9 to 25 pin
adaptor if necessary).

Plug the Foot Switch 'A" jack plug into its socket on the rear of the CITS.

Connect the supplied probe cable to the front panel SMA connector of the CITS and connect the
Microstrip probe to the probe cable.

If hard copies of waveforms and data are required, connect the printer as LPT1 using a standard 25 way
D to Centronics connector printer lead.

Power up the CITS and the host computer.
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2-5 Running  the program
To start the program, double click the CITS icon with the mouse or highlight the icon and press <Enter>.

After a few seconds the main CITS display will appear.

PROBE.TST - Polar CITS200
File Waveform aata log  ppt ions M a c r o  H e l p

Ohms

65

60

55

50

45

40

35

30
0 1  2  3  4  5  6  7  8  I n c h e s

Figure 2-1 The CITS200 Main screen

Note: the colours of the screen displays may be changed at the option of the user — the screen views
used in this manual may differ slightly from the system in use.

•

•

•

•
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2-6 Sys tem configuration
The System Configuration dialog allows the operator to specify the CITS type, CITS100 or CITS200,
reference impedance and calibration mode and add a user name and password. Specifying a password
will prevent unauthorised users from modifying the files which contain the test parameters.

The dialog also enables the operator to specify which of the serial communications ports of the host
computer will be used by the CITS.

From the Options menu select Config... to display the System Configuration dialog:

Metric Det
0  Beep on Tar i fa

 E l  Activate Pattsvord on Exit
Reference Impedance 50 r  Ohm*

Figure 2-2 The System Configuration menu

Specifying a user name
The User field is provided to allow users to add their company name to printouts. To modify the name,
use the <Tab> key to activate the User field, delete the existing name (if any) and enter the new name.
The name will be included in subsequent hardcopies of test results.

Specifying a password
Specifying a password is optional; if a password is specified, unauthorised users will be prevented from
modifying the system configuration, editing test files (files containing test parameters) or deleting logged
records. If a password is set it will be requested before these operations are permitted.

To specify a password, activate the Password box and type the password — up to 8 characters may be
used. For security, characters typed will be displayed as asterisks. If no password is required leave the
field blank.

Confirmation
If a password is entered a the CITS displays a confirmation box. The CITS requests that password be
retyped in the confirmation box to verify the original.
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Activate Password on Exit
If a password has been specified, exiting this screen with this box checked enables password protection
immediately; otherwise the password protection is not enabled until the software is next run.

Specifying the serial communications port
Commands and data are transferred over the RS232 serial communications link via one of the host
computer's serial communications ports.

The Com Port field allows the serial communications port through which the PC communicates with the
CITS to be specified or changed.

Typically, if a serial mouse is in use, it will be connected to serial communications port COM 1. The CITS
must therefore be connected to a different port.

The system displays the current communication port; specify a new communication port if necessary —
the system will enable the selected port.

Other serial communication parameters are set automatically by the CITS system.

Specifying the Instrument type
The current instrument type must be selected here. Setting the instrument type to CITS200 will enable
differential test options.

Note: Differential testing is only possible with the CITS200.

Reference Impedance
This must be set to the reference impedance value written on the rear panel of the CITS instrument.

Beep on Test Fail
If this box is checked the system produces an audible warning when a test fails.

•

•

•

•
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Metric Defaults
When this box is checked the Defaults button in the Test File Editor is made to generate distances in
metric units.

Calibration
The Calibration parameter specifies when the CITS performs a self-calibration.

Three modes of Calibration are available:-

Autocal
In Autocal mode the CITS self-calibrates automatically at a given interval in time. This may be specified
from 1 to 60 minutes (the default is 20 minutes). This is the normal mode of operation.

Cal On Test
In Cal on Test mode the CITS self-calibrates before every test. This gives the best possible accuracy but
slows down operation.

Cal On Demand
If Cal on Demand mode is selected the Calibrate Now command is added to the Options menu. Self-
calibration takes place only when the user chooses Calibrate Now from the Options menu.

Press the Help button to obtain information on each of these options.

To exit the System Configuration menu without recording any changes press <Esc> or click the Cancel
button.
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SECTION 3 GETTING STARTED

IMPORTANT
The CITS is an extremely sensitive measuring instrument. To prevent
damage to the CITS observe static precautions at all times. See
Appendix B for information

BASIC CITS OPERATION
The section discusses the basic operation of the CITS program using the verification test coupon included
with the CITS.

First time operators are encouraged to work through this section using the coupon and test files provided
to verify the correct operation of the CITS and quickly gain familiarity with the impedance testing
procedure.

This section assumes that the installation/setup procedure has been successfully completed.

Power up the CITS and PC, start Microsoft Windows and double-click the CITS icon to start the CITS
program. The CITS main screen is shown in Figure 3-1.

•

Figure 3-1 The CITS main screen
The CITS window may be increased in size by dragging the window borders with the mouse.

Press the Maximise button to increase the display size to full screen.
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3-1 Te s t i n g  the verification coupon
The coupon comprises three PCB traces of nominal impedance, 500, 750 and 1000; the CITS sotware
includes three test files associated with the coupon. The actual values measured at the factory are
recorded on the test coupon.

To test any PCB it is necessary to select the correct test file for the board under test. This file includes the
nominal impedance to be tested for, the test tolerance and the distance over which to test. In this section
we will test the verification test coupon supplied with the CITS.

Selecting a test file
From the File menu select Open... or press the Open... button on the tool bar with the mouse — the
Select Test File dialog box appears with the sample test files listed — see Figure 3-2.

The file Open... button

File Name:

diff.tst
dif12.tst
ip-50.tst
probe.tst
testi 00. tst
test50.tst
test75.tst

List Files of Lope:
Test Files (.Tst)

Directories:

wincits
testfile

Drives:
c: t J

Figue 3-2 The Select Test File dialog

Cancel I

❑  Read Only

In this example we will test the coupon's 500 trace using the TEST50.TST file.

Select the file by either clicking the mouse on its name in the file list window or stepping the selection
down to it with the cursor direction keys. Click on OK to select the file.

The CITS loads the selected test file and displays the impedance and distance scales and a cross
hatched area indicating the region over which impedance will be tested — Figure 3-3. The impedance
scale indicates the nominal impedance (in this case 50E2) and acceptable impedance range (45 — 55E2).

•

•

•

•
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Figure 3-3 The CITS test window

Testing the coupon
Note: Ensure the Microstrip probe signal pin is connected to the signal pad and the probe ground pin to
coupon ground pad. Typically, ground connections have square pads to distinguish them from signal
pads.

To test the coupon connect the Microstrip probe across the 5052 test impedance and press the foot switch
or click the Test button. Take care not to touch the track on the coupon during testing.

The CITS Test button

The system will take a few seconds to set up the instrument for testing and will graph the impedance of
the 50Q trace.
The CITS displays the traces impedance against the test program limits
— Figure 3-4.
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tile waveform a t a l o g  Options Macro  H e l p

LI

Ref mumei,
Overlay
Current
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:Ready.. AutntitigNO*..

Figure 3-4 Graph of 50Q impedance within limits

The waveform in Figure 3-4 remained between the crosshatched area over the whole of the tested region
so the CITS recorded a PASS.

3-2 Displaying the impedance statistics
The CITS includes the PASS/FAIL result for the test and provides a display of the average, standard
deviation, minimum and maximum impedances over the tested area in the associated boxes on screen
along with the impedance waveform.

•

•

•

•
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If the displayed waveform extends into the crosshatched area the CITS records
a FAIL — see Figure 3-5.
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0 1  2  3  4  5  6  7  8  I n c h e s

Ready.. , A u t o c a l  -14d0 r

Figure 3-5 Graph of 5052 impedance outside limits

(If the CITS recorded a FAIL check for correct probe/coupon polarity and good contact between the
Microstrip probe and the 5052 trace on the coupon and try again.)

Repeat the procedure for the 750 and 10052 nominal impedance traces on the verification test coupon
using the TEST75.TST and TEST100.TST files respectively.
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3-3 Ex i t ing  the program
Select Exit from the File menu or press AIt+F4 to leave the program and return to the Windows Program
Manager.

e

•

•

•
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SECTION 4 S Y S T E M  OPERATION

IMPORTANT
The CITS is an extremely sensitive measuring instrument. To  prevent
damage to the CITS observe static precautions at all times. See
Appendix B for information

USING THE CITS FOR WINDOWS PROGRAM
Double clicking the CITS icon starts the CITS FOR WINDOWS program.•

•

•

When the CITS program runs, the main CITS screen is displayed loaded with the last test file used.

Figure 4-1 shows the CITS main screen
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10
0

TEST5 0.TST - Polar CITS2 0 0

1 2 3  4  5  6  7  8  I n c h e s

iReady A u t o c a l -  N

Figure 4-1 The CITS main screen

4-1 T h e  CITS screen
The CITS screen comprises five sections:

• t h e  menu bar
• t h e  tool bar
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• t h e  main test window
• t h e  statistics/results area
• t h e  status bar

The main screen window can be maximised to full screen view if desired — click the Maximise button (or
press AIt+Spacebar+X on the keyboard).

4-2 T h e  CITS menu bar
All CITS commands are available from pull-down menus; commands can be accessed via the keyboard
or mouse (see GUIDE TO THE MANUAL).

The File menu
The File menu provides the commands for working with test files — the user is able to:

• c rea te  new test files
• o p e n ,  save and edit existing files
• execute  tests using the selected file
• e x i t  from the CITS program

When the File menu appears the last four test files opened are listed in reverse order.

The Waveform menu
The Waveform menu allows the operator to:

• s a v e  the current waveform to disk for later viewing
• v i e w  recorded waveforms
• s a v e  the current waveform as the reference waveform for a test file — the waveform is then

displayed whenever the test file is selected

The Datalog menu
The Datalog menu allows test data to be automatically logged to a text file for archiving and subsequent
analysis. The log file can be printed out or imported into a spreadsheet.

Automatic data logging can be toggled on or off via the Autolog command (Autolog is ON by default).

Viewing logged data
Test data is added to the log file as each test is logged. The View Log command enables the Data Log
Window which displays the entries in the log file. To view data as it is being logged select View Log in the
Datalog menu.

The log window may be kept in constant view by selecting Always on Top from the Datalog menu.

The Options menu
Users can change operating conditions during normal CITS operation via the Options menu:

• C l e a r  the screen of the current waveform and data.
• Over lay Multiple Waveforms — allowing comparison of a sequence of test results.
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• Change  the test window screen colors.
• Spec i fy  the host computer's serial communications port.
• Spec i fy  the instrument type — setting this to CITS200 will enable differential test options
• Spec i fy  the Reference Impedance — this must be set to the calibration constant value

written on the CITS rear panel
• S e t  the calibration mode — the CITS can calibrate automatically at a given time interval,

calibrate before every test for best possible accuracy or calibrate only when the user
chooses the Calibrate Now command.

• D isp lay  Delta Time cursors — the Delta Time cursors may be used to measure
propagation delay times. The CITS calculates the time interval between the two cursors
based on the setting of Vp (velocity of propagation) in the current test file — see Section
5-3.

The Macro menu
The Macro menu allows the user to create and modify Test File Macros — lists of test files which may be
cycled through in sequence automatically or manually selected.

When a macro file is loaded the CITS displays a list of the individual test files in the sequence. The
operator can select test files from the list using the mouse or keyboard arrow keys or use the CITS foot
pedal to advance through the list and perform each test in the sequence without the use of mouse or
keyboard operations.

If the Autoload Next command in the Macro menu is selected, as each test is completed the next test file
in the sequence is automatically loaded. The operator advances to the next test in the list with the mouse
or the arrow keys on the keyboard.

Autoload Next is turned on by default. If Autoload Next is turned off the CITS will not automatically
sequence through the tests. Steps in the sequence must be manually selected then run.

Test results are displayed next to each test file as testing progresses.

The Help menu
The Help menu includes concise explanations and instructions for every CITS operation — press the Fl
function key to access the on-line help from anywhere in the program.

4-3 T h e  CITS main tool bar
The CITS main toolbar contains buttons that provide quick mouse access to the most frequently used
CITS commands:

File Open... — press this button to display the Select Test File dialog box and
choose a test file.

File Save — save the current test file.
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a Print waveform — send current waveform to printer for hard copy.

Execute Test — perform a test using the selected test file.

Edit Test File — open the test file editor dialog box to edit the current test file.

Clear — Clear the test window of waveform and statistical data.

•

•

•

•
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4-4 T h e  statistics/results area
The CITS displays the PASS/FAIL result of a test and the statistical data over the tested region of the
displayed waveform in the statistics/results area.

On completion of a test the resulting test waveform is displayed, a PASS or FAIL is reported and
displayed statistical data is updated.

Four values are displayed:

• Average
• Standard deviation
• Minimum
• Maximum

4-5 T h e  Status bar
The CITS status bar displays activity and status information and messages to assist the operator.

Figure 4-2 The CITS status bar

The status bar comprises three sections:

• Current  activity — the CITS reports its current activity, Ready... (awaiting instructions),
Calibrating..., Setting up..., Testing..., etc.

• Calibration mode — indicates the currently selected Calibration mode (Cal on demand — manual
calibration, Autocal — timed calibration or Cal on Test — calibration before each test is
executed).

• Operator  Message — special instructions for testing, etc.
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'_tst
diff.tst
diff2.tst
ip-50.tst
probe. tst
testi 00. tst
test50.tst
test75.tst

4-6 Tes t ing  printed circuit boards
The procedure for testing printed circuit boards is similar to that described for the verification test coupon
in the previous section:

• Se lec t  a test file if one exists (or create a new file and define the board test parameters —
see Section 5 — Editing Test Files).

• Connect  the Microstrip probe to the board terminals or connections
• Execute the test via the File menu or click the Test button.
• Supp ly  board details for data logging in the Board Information dialog box.
• F o r  convenience, users are recommended to use the Foot Switch to operate the CITS in a

"hands-free" mode. Using the Foot Switch allows the operator to hold the probe in contact
with the board under test with both hands.

Selecting a test file
Prior to testing a board or batch of boards a test file containing test parameters associated with the board
type must be selected (or created if none exists). See Section 5 — Test File Editor for details of creating,
modifying and saving test files.

Select the File menu and the Open... command — the CITS displays the Select Test File dialog:

File Name:

List Files of Lope:

Directories:
c:Uvincits\testfile

wincits
testfile

Drives:
c:

Figure 4-3 Selecting a test file

K O K

citiCgoi

❑  Read Only

The Select Test File dialog opens with the list of .tst files in the current directory displayed. (Test files
may also be selected from the recently used file list from the File menu.)
Select the board test file by clicking the file name with the mouse (or press the <Tab> key to move into
the file list field and use the cursor keys to highlight the test file) — press OK to load the file.

The CITS displays the name of the selected file in the Title Bar and the test file's impedance and distance
scales in the test window.

•

•

•

•
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Figure 4-4 CITS screen with test file loaded

Executing the Test
Most board testing will be performed with Microstrip probes. Using Microstrip probes will minimise
measurement errors due to mismatch between the impedance of the measurement system (500) and the
track under test.

Keep to a minimum the number of changes in impedance between the CITS and the PCB track. The CITS
output impedance is rated at 500 so as far as possible use cabling and connectors from the CITS to the
PCB track with 50Q characteristic impedance.

For more information and hints on testing PCBs see the notes at the end of this section.

Locate the Microstrip Probe in position on the circuit board under test.
Select the Execute Test function (using the Foot Switch will probably be found most convenient).

When the test screen is displayed the limits of tolerance defined in the test file for the tested portion of the
track will be indicated by the cross-hatched areas (at installation the CITS test window is set to its default
— red cross-hatched areas on a black background — see System Configuration for information on
changing screen colors).

During a board test the system checks that the displayed impedance waveform falls within the limits
defined in the test file.

If successful the CITS records a PASS — Figure 4-5.
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PROBE.TST - Polar CITS 200
File Waveform Datalog Options Macro  H e l p
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Figure 4-5 PASS screen

As each test is completed the Board Information box is displayed so that test results may be logged to a
log file — see Logging Test Data.

•

•

•

•
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4-7 Logging Test Data
The Datalog function allows the operator to test and record the results of a series of tests on a board or
batch of boards. The CITS creates a log file (a text file containing test data) for archiving and subsequent
analysis.

The log file is stored in comma delimited form — suitable for import into most spreadsheet programs and
can be printed out for hard copy.

The log file is stored under the same name as the test file but with the .wlg file extension. (If data logging
is performed while running a macro the log file is stored under the same name as the macro file but with
the .csv extension — see Section 5-7 — Test File Macros).

To enable logging select the Datalog menu and ensure Autolog is turned on. Autolog is turned on by
default.

Test the board using the associated test file; when the test is complete, the Board Information dialog
box is displayed — Figure 4-6. Enter the details for the board under test — serial number, date code and
operator name and press OK.

C:'s,WINCITS‘TESTFILEtPFIOBE.WLG,

Figure 4-6 Datalog information dialog box

Each time data is logged the user is asked to confirm the board information.

Note: If a numeric value is entered into the Serial no field (e.g. SNO01), each time test results are added
to the Log the numeric value will be automatically incremented by one. This value may be edited by the
operator if necessary.
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Press Cancel if the current results are not to be logged (in the case of invalid data due to bad
probe/board connection, etc.).

Viewing Log Data
To view data as it is being logged select View Log in the Datalog menu to enable the Data Log window
— Figure 4-7.

0.23 2 3 : 3 9  0 3  Oct 95 P R O 6 E , I S T
23:43 0 3 ` -Oct 95 P F 1 0 9 § A S T

Figure 4-7 The Data Log Window

The Data Log window
The Data Log window displays all logged entries in the log file.

Each entry comprises a subset of the logged data — board details, test date and time and the result of
each test are included along with the average and standard deviation statistics for the board.

(If the Data Log window obscures the test screen press and hold the left mouse button down in the Data
Log window title bar and drag the Data Log window so that the test window is visible.)

Test results are stored sequentially as records in the log file. If necessary, use the scroll bar to scroll
through the list when inspecting records in the log.

•

•

•

•
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Initialising the log file
Press the Initialize button to clear all test data from the log file.

Caution: Selecting Initialize will clear all entries in the log.

Deleting records
To delete a single record from the log file, scroll through the list of entries, select the record with the
mouse or the keyboard cursor keys and press the Delete button. The record will be permanently deleted.

Printing logged data
To print logged data press the Print button — the Print... dialog box is displayed:

Print...

Figure 4-8 Selecting logged records for printing

Click the All option button to print the complete log.

To select a range of records for printing click the Selection button and type the starting and ending record
numbers in the From Record and To Record text boxes. Press OK.

The log window may be kept in constant view by selecting Always on Top from the Datalog menu.
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4-9 U s i n g  Delta Time Cursors
If the velocity of propagation, Vp, of the track under test is known, propagation delay times may be
measured by positioning the Delta Time Cursors at the beginning and end of the test specimen.

To enable the cursors select Delta Time from the Options menu.

The cursors will appear in the graphical display area and a readout of the time interval between them is
displayed to the right of the tool bar buttons — see Figure 4-9.

PROBE.TST - Polar CITS 200
File Wa v e f o r m  Datal log Op t i ons  M a c r o  H e l p
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Figure 4-9 Using the Delta Time Cursors to measure propagation delay

To position a cursor click the left mouse button on the triangular marker at the top of the cursor (the
selected marker changes to a grey rectangle); drag the marker into the display area and place the cursor
onto the required location on the waveform. Release the mouse button.

The system calculates the time interval between the two cursors based on the setting of Vp (velocity of
propagation) in the current test file — see Section 5-3.

•

•

•

•
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If the plotted waveform crosses into either of the cross-hatched areas the CITS system will report a FAIL
— Figure 4-10.

File Waveform Datalog Options Macro  H e l p
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Figure 4-10 FAIL screen
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4-10 Printing waveforms and test results
Select the Print function to produce a printed copy of the results of a board test.

The system will prompt for information which will be printed with the test results, Board serial no., date
code, the operator's name and comments — Figure 4-11.

02-APR-95

JB

PT FE - 40 deg C - 90% RH - 4 days

Figure 4-11 Waveform Information dialog

Select OK to proceed with printing. The current results plus any overlay and reference waveforms
enabled are printed along with test file and results data.

A sample printout is included overleaf.

4-11 Recording test waveforms
The Record Current Waveform function allows the operator to store a test waveform on disk. Test
waveforms are stored as files with the .dat file extension.

The system will display the Waveform Information dialog box — see Figure 4-11 above — requesting
the board serial no., date code, the operator's name and comments.

Step through the information fields with the <Tab> key. Press OK when all fields are completed — the
Save Waveform File dialog box is displayed.

Type a new file name in the File Name box and select OK

To overwrite previously stored data select the name of an existing file from the list and press OK.

A warning message requests confirmation of the decision to replace existing data with the current test
results.

Viewing recorded waveforms
Waveforms stored on disk with the Record Current Waveform function may be retrieved and printed
with the View Recorded Waveform command.

Select View Recorded Waveform from the Waveform menu — the list of previously recorded
waveforms is displayed.
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Use the cursor keys or the mouse to highlight and select a file from the list and press OK. The recorded
waveform and associated statistics are displayed.

hms
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Record

0 1  2  3  4  5  6  7  8  I n c h e s

Figure 4-12 Viewing the recorded waveform and statistics

Note that when viewing test waveforms the message Recorded Waveform appears in the display.

Further waveforms may be inspected using Open on the File menu and results may be printed out using
the Print command as described earlier.

To return to normal operation select Close from the File Menu.

The Recorded Waveform tool bar
When viewing test waveforms a restricted menu (the File menu) and toolbar are displayed.

Press this button to view other stored waveforms.

Press this button to return to normal operation.

Press this button to print out the displayed waveform.
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4-12 Reference Waveforms
The CITS incorporates the facility to store a reference waveform for every test file — the reference
waveform is displayed as an example of a good trace when the test file is selected.

Setting a Reference Waveform
With a good waveform displayed, to save the current waveform as the reference waveform for a test file
use the Set Reference Waveform command from the Waveform menu. The waveform is then displayed
whenever the test file is selected. To make this change permanent save the test file and reference to disk
using the Save command from the File menu.

Clearing a Reference Waveform
To clear the current reference waveform for a test file use the Clear Reference Waveform commend
from the Waveform menu. To make this change permanent save the test file to disk using Save from the
File menu.

•

•

•

•
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4-13 Overlaying waveforms
The Overlay command from the Options menu allows waveforms from a series of test operations to be
superimposed, or overlaid.

The Overlay option displays a sub-menu from which the user specifies the number of waveforms to be
superimposed — 2, 5, 10, 15 or 20.

With the Overlay option selected, the waveform window is not cleared between board tests, so the results
of the last 2, 5, 10, 15 or 20 tests will appear superimposed until Overlay is deselected (set to Off) —
older test results will be discarded — Figure 4-13.

B e  Waveform Datalog Options, Macro H e l p

Avg,-.4'48.10

i S D  0.39

Min = 47.64

Ref
0 verlay
Current
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65

60

55

50

45

40

35

30
0 1

Autocal -15 min

2 3  4  5  6  7  8  I n c h e s

Figure 4-13 Waveforms superimposed in Overlay mode

Test the board or batch of boards as described earlier — the test waveforms from each test operation will
be overlaid on the previous waveforms until Overlay is switched off.

Note: the PASS/FAIL result and information appearing in the Statistics area refer to the most recent test
only. The Statistics area does not accumulate data.

Use Clearscreen from the Options menu or the Clear button to clear the screen.

4-14 Exiting the CITS program
Select Exit to leave the CITS program and exit to the operating system.
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4-15 Notes on testing printed circuit boards
Board testing should normally be carried out using Microstrip probes. These probes are designed to
minimise measurement errors caused by mismatch between the impedance of the measurement system
(5052) and the PCB under test.

Operation is possible however using direct connections to a board.

Note the following observations when not using the Microstrip probes.

Keep impedance changes to a minimum
When setting up PCBs for test, best results will be achieved by keeping to a minimum the number of
changes in impedance between the CITS and the PCB track.

The CITS output impedance is rated at 50Q so as far as possible use cabling and connectors from the
CITS to the PCB track with 50Q characteristic impedance.

Use a probe which minimises the impedance discontinuity at the interface to the PCB.

Use high quality cabling.
Always use high quality cable. Low quality cable may show series resistance. Series resistance will be
displayed as a gradual increase in characteristic impedance along the cable.

Inexpensive cables also tend to have greater impedance variations over their length and at the
connectors at each end.

Precision cables (5052 ±1Q) are provided with the CITS.

Compensate for unavoidable impedance changes
When testing 75Q tracks using 5052 cabling the level of ringing and aberrations in the leading edge of the
plot is noticeably worse than for a 5052 track. This is because of the step in impedance at the probe to
PCB interface.

This can be compensated for in two ways:

(i) Measure impedance only over the relatively flat portion of the plot.
Set the Test from: and Test to: parameters to avoid ringing and aberrations in the leading edge
of the TDR trace.
(ii) Use a 7552 Microstrip probe so that aberrations occur at the 5052 cable to probe interface and
there is a smooth transition at the probe to PCB interface.
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SECTION 5 EDIT ING TEST FILES

TEST PARAMETER FILES
Each board type to be tested is tested in accordance with a set of test parameters. Each set of
parameters is stored in a test file.

Figure 5-1 diagramatically illustrates the test parameters specified in the test file.

Zo

Impedance

Polar CITS100

Front
Panel

PC display
M I N  MEMIDIF, M O M =
MINN MNIENNINIINEIN MI ormalowamiim
1 1 1 1 C M I E M M E O S I M M =
I M M O =

MEN21.01M . = = l =
M I M O  M = = 1 =

■OMPIMPII  MMIONIUMO

P ) 1 ( R  T

Test File Parameters
B

I

Figure 5-1 Test parameters defined in a test file

In Figure 5-1 letters P, A, B, T signify the test parameters listed below:

P =  P r o b e  Length
A =  T e s t  From
B =  T e s t  To
T =  T e s t e d  region (B — A)

}Tolerance

Distance

Test
Coupon

5-1



CITS FOR WINDOWS OPERATOR MANUAL

5-1 T h e  Test File Editor
Test parameters for boards under test may be defined or modified using the integrated Test File Editor
— see Figure 5-1.

Figure 5-2 The Test File Editor

5-2 Creat ing and modifying test files

Creating a new test file
To create a new test file choose the New command from the File menu.

This will load a test file called Untitled.tst and open the test file editor dialog using default test parameters
— see Figure 5-2.

Each parameter is defined and displayed in a parameter field. To create or edit a test file, modify the test
parameters as required and then use the OK button to confirm the field edits.

The fields are described in the following sections.

•

•

•

•
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5-3 B o a r d  test parameters

Customer
The Customer field is provided so that the customer name may be included as part of the data for a
board (e.g. "XYZ Computers Ltd"). The customer name will be printed out with the test results.

The Customer field may include up to 20 characters of text.

Board type
The Board type field allows up to 20 characters of text to be included to define the type of board under
test (e.g. "Main CPU Board").

The board type will be printed out with the test results.

Message
The Message field allows specific instructions to aid the operator during testing to be included with the
test file (e.g. "Use 7551 Microstrip Probe").

Text typed into this field will be displayed in the status bar of the main window when this test file is
selected.

Impedance
Use the Impedance field to define the nominal impedance in ohms of the PCB track under test.

This field must contain an integer in the range 10 to 500 ohms.

Tolerance
This parameter defines the tolerance about the nominal impedance to which the track will be tested. The
tolerance must be set to a value in the range 0.1% to 100% — the CITS will accept fractional tolerances,
e.g., 0.5%.

Ohms/div
The vertical axis on the PC screen is scaled in ohms per vertical division. The scale may be set to one of
the pre-defined values 1, 2, 5, 10, 20 or 50 ohms/div.

Press the up or down arrow keys to step through the vertical scale value options.
Choose the scale factor which gives optimum display — lower values display the waveform in greater
detail.

Regardless of the vertical scale factor chosen, the display will center vertically about the value specified
for the nominal impedance.
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Distance units
The horizontal axis on the PC screen displays the distance along the PCB track under test.

The Distance units field specifies the units (inches, feet, millimeters or meters) which will be used for the
distance related fields. It defines the distance units used to specify all the distance parameters and those
used on the horizontal axis of the displayed graph.

Probe length
The Probe length field specifies the distance from the CITS front panel connector to the beginning of the
displayed graph on the PC (see Figure 5-1).

If the supplied cable and a Microstrip probe are used Probe Length can be left at its default value (45
inches).

If a different connection method is used Probe Length can be used to define the starting point of the
display (i.e. the left edge of the graph) in terms of the distance from the CITS front panel. For example, if
37 inches is specified the display will show a graph of impedance starting 37 inches from the CITS.

Probe length may be set in the range:

0 to 600 inches
0 to 50 feet
0 to 15 meters
0 to 3000mm.

Test from
This parameter, along with the Test to parameter enables the user to specify the length of PCB track of
interest for testing.

This allows the user to avoid testing for controlled impedance in an area where the CITS trace may be
ringing (e.g. where a sharp change of impedance occurs in the test system).
The Test from parameter specifies the distance from the end of the test probe to the start of the length
over which impedance is to be tested (see Figure 5-1).
It defines the start of the tested area within the display window

Test from may be set in the range:

0 to 600 inches
0 to 50 feet
0 to 15 meters
0 to 3000mm.
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Test to
The Test to parameter specifies the distance from the end of the test probe to the end of the length over
which impedance is to be tested (see Figure 5-1). It defines the end of the tested area within the display
window.

It will normally be set to a point just before the plot starts rising toward infinity due to the open circuit end
of track.

Test to may be set in the range:

0 to 600 inches
0 to 50 feet
0 to 15 meters
0 to 3000mm.

Note that Test to must be greater than Test from.

Loss Compensation
The Loss Compensation field may be used to compensate for any series loss in the track being tested.

Any series resistance will appear as a ramp in the waveform with impedance increasing linearly with
distance. Series resistance simply adds to the characteristic impedance over the length of the waveform.

This phenomena is caused by the DC resistance of the track combined with high frequency skin effects
reducing the effective cross-sectional area.

Series loss can be compensated for by adjusting the slope of the waveform by a specified number of
ohms/meter or ohms/foot. This cancels out the series resistance leaving the true characteristic
impedance displayed.
Note: Series loss may be distinguished from the case of a slightly tapered track by testing from both ends
of the trace. In the case of series loss the impedance waveform will appear the same from both ends.

For normal use it is suggested that loss compensation should be left disabled — the default state. In
some instances, however, where long conductors or those with small cross sectional area are being
tested enabling loss compensation may prove useful.

Select User to display the Series Loss text box — use the left and right arrow keys or mouse to locate the
cursor then type in the desired value.

See SPECIFICATIONS for the range of acceptable values.

5-5



CITS FOR WINDOWS OPERATOR MANUAL

Velocity of Propagation (Vp)
The Velocity of Propagation (Vp) is the speed at which electrical signals propagate along a cable or
printed circuit board trace. Vp is given as a percentage of the speed of light, c.

The speed of the signal depends on the dielectric coefficient of the medium in which it travels. For
simplicity of operation the CITS program assumes that all cables and PCB tracks have a velocity of
propagation of 66% the speed of light. The CITS calculates displayed distance from time based on a
default Vp of 0.66. This value will be found valid for typical coaxial cables and circuit board traces.

This will, however, result in some apparent errors in the indicated distances in systems which have
significantly different velocities of propagation. For example, airlines, which have a very high velocity of
propagation (98 to 99% the speed of light), will appear shorter than their true physical length if both are
measured with the default Vp. Since the purpose of the CITS is to measure impedance, for most
applications the accuracy of the distance scales will probably not be critical.

If desired, the Vp used for display of test waveforms can be adjusted for the display window. If Vp is
correctly adjusted then the displayed length of any tested specimen will match its physical length. This
adjustment is applied to all of the displayed waveform.

For most applications leave the Vp setting at Default.

Selecting the User option displays a text box containing the current value of Vp. With the text box
displayed use the left and right arrow keys or the mouse to locate the cursor and type in the desired
value.
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Differential
This option is only available when the instrument type has been specified as CITS200 in the system
configuration screen. If the instrument is a CITS200, differential testing may be enabled using this control.

The CITS100 does not support differential impedance measurements — the CITS100 will show the
Differential options greyed out.

Normal controlled impedance structures comprise a single signal conductor and a ground plane or
planes. Impedance measurements made between the signal and ground are sometimes referred to as
single ended.

Where higher performance (e.g. greater noise immunity) is required a more complex type of controlled
impedance structure is employed — that of a differential pair of signal conductors. The lines are driven as
a pair with one line transmitting a waveform of opposite polarity to the other.

At the receiving end one signal is subtracted from the other so any noise induced in both lines is
cancelled out. This is a technique commonly used to increase noise immunity in high speed digital and
analog systems.

The characteristic impedance of a differential pair, therefore, is affected not only by the impedance of
each line of the pair to ground but also by the interaction of the signal lines with each other.

To facilitate differential measurements the CITS200 provides two SMA connectors on its front panel.
Differential testing is performed using the IPD100 Differential Probe.

It is critical for a differential test that the probe cabling is of matched impedance and length for both
channels.

It is recommended that the cables supplied with the instrument are used.

To perform a differential test check the On option in the Differential section.

Note: With the exception of the Customer, Board type and Message fields, each field must contain a
test parameter; the Customer, Board type and Message fields may be left blank.
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Test Method
When this parameter is set to Normal the CITS will record a FAIL if the trace is out of tolerance at any
point over the tested area.

Selecting Average will cause the test to fail only if the average impedance is out of tolerance.

When Average is selected the test limits are displayed as the diagram below:

Figure 5-3 Average Test Method display window

Modify the test parameters as required and then use the OK button to confirm the new values.

5-4 S a v i n g  the test file
When all test parameters have been specified press the Save button to store the file as a new test file or
use the Save or Save As commands from the File menu. The system will display the Save As dialog box
to request the new file name.

1!0 Press the Save button to save the file.

Note: if the Untitled.tst file is overwritten the modified parameters become the defaults for a new test file.
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Naming test files
Names assigned to test files must conform to the MS-DOS conventions for file names. File names must
be unique and may contain up to eight characters.
The PC operating system will allow the following characters to be used in file names:

Letters A to Z and a to z
Numbers 0 to 9

and the following special characters:

Spaces, commas, periods and backslashes ( \ )are not permitted in file names. For more information on
file naming conventions, consult the MS-DOS operating system user guide.

Saving test files under new names
Users will frequently need to rename files or create files with test parameters similar to existing files. It will
often be most convenient to modify and rename an existing file.

Select the existing file using the Open command from the File menu, press the Edit button to edit the file,
modify test parameters as required, press the Save As button and name the new file.

5-5 U s i n g  existing files as templates
An alternative, and in many cases quicker, method of creating a new test file is to open an existing test
file, edit it and then save it under a new name. If this is a new test file, select one of the three supplied
templates and edit the parameters as required (the procedure for editing test parameters and saving files
is described below).

Modifying an existing test file
To create or modify the current test file select the Edit command from the File menu or press the Edit
button — the Editor will open with the selected file displayed. Change the test parameters as required and
save the file.

I n P r e s s  this button to edit the current test file.

Press Alt-F4 to exit the Editor.
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5-6 Pr int ing test files
Select the Print function (or Alt-P) to obtain hard copy of test files.

5-7 T e s t  File Macros
The CITS incorporates facilities to create and run sequences of test files — called macros
the process of performing a complex series of tests.

Macros are generated using the Macro Editor. Using the Macro Editor the user specifies a
to be run in sequence; the test files are cycled through automatically.

When a macro file is loaded the CITS displays a list of the individual test files in the macro
the right of the waveform display area. The current test file is shown highlighted.

Test files may be selected using the mouse or keyboard arrow keys — Figure 5-4.

MAINBRD1.TST {MAINBRD.MRF} -  Polar CITS 200
"notaing glptitons
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t,,IAINBRD1
Rti2

AINBRO3
MAINBAD4
MAINBAD5
Macro End

Figure 5-4 Main screen with displayed macro sequence

— to automate

list of test files

sequence to

The CITS foot pedal can be used to advance through the list and perform each test in the sequence
without the use of the mouse or keyboard. Test results (PASS/FAIL) are displayed next to each test file as
testing progresses.

•

•

•
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Creating a new macro
To create a new macro file select New from the Macro menu. The CITS loads the macro file
Untitled.mrf.

The Macro Editor window is displayed to allow test files to be added to the macro sequence — Figure 5-5.

Figure 5-5 The Macro editing screen

Note: If macro files already exist it will often be more convenient to select an existing macro file, edit this
as desired and then use Save As on the Macro menu to save it as a new file.

If an existing macro file is opened The Macro Editor displays a list of all the test files in the test sequence.

Test files can be inserted at any point in the test sequence or deleted from the test list as required.

Selecting the Print function produces a hard copy of the test sequence.
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Adding a test file to a macro
Select the position in the test list (using the mouse or cursor keys) and press the Insert button — the
CITS displays the list of available test files:

Select Test File to Insert

File Name:

diff.tst
diff2.tst
ip-50.tst
mainbrdl.tst
mainbrd2.tst
mainbrd3.tst
mainbrd4.tst
mainbrd5. tst

List Files of jype:
Test Files r.Tst) LJ

Directories:
cAwincits‘testfile

05 wincits
testfile

Drives:
c:

Figure 5-6 Adding test files to a macro

❑  Read Only

Select the test file and press OK — the file will be added to the list. Continue adding test files until all test
files required are included in the macro list — see Figure 5-7. Press OK to confirm the files and close the
Macro Editor.

:\WINCITS\TESTFILEVAAIN8RD1.TST
:\WINCITS\TESTFILE\MAINBRD2.TST
•WINCITS \TESTFILE \MAIM:11)3.1ST
:\WINCITS\TESTALE\MAIN8AD4.1ST
:WIINCITS1/4TESTFILBMAINBRD5.TST

Figure 5-7 Completed macro list
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Saving a macro
To save the new macro file use Save or Save As from the Macro menu. The CITS will request a name
for the new file.

Loading a macro
To load a macro Select Open from the Macro menu. The CITS displays the Select Macro File dialog
box:

File Name:

List Files of Iype:

Select Macro File

Directories:
c:lwincitsltestfile
(22,

wincits
testfile

_J

Drives:
c:

Figure 5-8 Selecting a macro file

A t I r c t i v A A t

❑  Read Only

Editing a Macro
To edit the current macro file select Edit from the Macro menu. The Macro Editor window is displayed
with the current macro loaded. The Editor allows test files to be added to or removed from the macro file.

Press the Insert button to add a file to the list as described earlier. To remove a file from the list highlight
the file with mouse or arrow keys and press the Delete button.

Note: If no macro file is currently active the Select Macro File dialog box is displayed to allow a macro file
to be selected.

Closing the Macro Editor
To finish the current editing session and close the Editor press the Close button.
Select the macro file of interest and press OK.

With the macro loaded the test file sequence is displayed to the right of the waveform display area. The
first file in the list is highlighted to indicate that this is the current test file.
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Running a macro
Select the test to be run and press the foot pedal to run the test.

If the test passes the next test file in the sequence is automatically loaded (check that Autoload Next in
the Macro menu is turned on — Autoload Next is turned on by default). To advance to the next test in
the list manually, use the mouse or the arrow keys on the keyboard.

Selecting tests manually
If Autoload Next (in the Macro menu) is turned off the CITS will not automatically sequence through the
tests. Steps in the sequence must be manually selected then run.

Macro data logging
If Data Logging is selected, when the user reaches the end of the list of test files the Board Information
dialog box is displayed.

Enter the details for the board under test — serial number, date code and operator name as described in
Section 4-7 — Logging Test Data.

If data logging is performed while running a macro the log file is stored under the same name as the
macro file but with the .csv extension.
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Symptom Test
Communication Error
reported by the host
computer

i. Check CITS power is switched on.
ii. Check CITS green BUSY LED is lit for a few seconds on power

up then extinguished. If the green LED stays lit, the CITS is
faulty; refer to the supplier or agent

iii. Check the connection of CITS to the PC.
iv. Check that the cable used is the cable supplied with the CITS.
v. Check that the COM port connected to the CITS matches that

selected via the System Configuration screen.

Foot switch not working i. Check that the RS232 cable in use is the cable supplied.
ii. Ensure that if a 9-25 way RS232 adaptor is used all 9 signal

lines are connected.

Printer fails to work i. Check the printer is switched on.
ii. Check connection of the PC to the printer.

SECTION 6 MAINTENANCE AND FAULT FINDING

WARNING This instrument should only be serviced by a qualified
electronics technician.

Refer all servicing to qualified service personnel. Polar Instruments publishes a CITS Service Manual to
assist the service technician.

•

•

•

Fault diagnosis
The following symptoms may be investigated by the user. More serious faults should be referred to
qualified personnel.
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Cleaning
Clean the CITS200 with a cloth lightly moistened with water with a small amount of mild detergent.
Alternatively, a cloth lightly moistened with alcohol (ethanol or methylated spirit) or isopropyl alcohol (IPA)
may be used.

Do not spray cleaners directly onto the instrument.

Technical Support
For technical support contact your local Polar Instruments distributor or Polar Instruments.

Microstrip probes
If a different pitch between the ground and signal pins on the Microstrip probes is required this may be
adjusted with the aid of a soldering iron. (In the event of damage or loss to the spring loaded pins,
replacements are obtainable from I.D.1 or their local agents. The order code is SIE 3.8 G)

•

•

•

•
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APPENDIX A CHARACTERISTIC IMPEDANCE

Characteristic Impedance of conductors
The characteristic impedance of a conductor is a function of the dimensions of the conductor and the
dielectric constant Er of the insulating material.

The diagram below includes equations for calculating the characteristic impedance of coaxial cable,
microstrip and stripline.

•

•

I

H w — d
I Track I

AC Ground

AC Ground

AC Ground

a. Coaxial Cable

DZo = 1 3 8  l o g
I T  1 0  d

b. Microstrip

4
t

T 1Zo - [  8 7   ]  [  in 5 . 9 8 h  ]

c. Stripline

Er+1.4171 0 . 8 w  + t

Zo = [  6 0  1  in  [  4 b
/ 7 7  0 . 6 7 7 r  (0.8w+t)

where w/[bi]<0.35 and tjb<0.25

Figure A-1 Typical conductors and associated impedance equations
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Figure A-2 Reflection magnitude v discontinuity impedance for a 5052 Zo, step output TDR

Determination of characteristic impedance
The CITS displays a graph of the characteristic impedance of a specified length of PCB trace. This is
achieved by calculating the impedance along the length of the cable or PCB based on the size of the
reflections measured using time domain reflectometry.

The above graph shows the size of reflection from an impedance discontinuity encountered by the out-
going pulse of a 5051, step output TDR such as the CITS.

The CITS software translates the magnitude of voltage reflections measured by the TDR into a linear plot
of impedance against distance. Note that the size of the reflection is not linearly related to the impedance
discontinuity. As the impedance gets larger the slope of the curve is reduced so that at high impedances
a large change in impedance will only cause a small change in reflection. Consequently the accuracy of
measurements of high impedances is reduced.

•

•

•

•
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APPENDIX B ELECTROSTATIC DISCHARGE

The probe/input circuitry of the CITS includes sensitive components that are susceptible to
damage from electrostatic discharge — precautions must be taken to avoid static discharge
into the probe.

Protecting the CITS from electrostatic discharge
Many of the components in modern instruments like the CITS employ internal construction which may be
damaged by electrostatic discharge (ESD). Such components are often referred to as static sensitive.

•

•

•

Damage caused by electrostatic discharge may be severe enough to result in the complete and instant
failure of a component. Often, however, components are not destroyed but merely degraded and failure
occurs in later use.

Some devices are sensitive enough to be damaged or degraded by electrostatic discharge of only several
tens of volts, voltages not uncommon at a typical unprotected work station.

Everyday activities such as applying tape from a dispenser, walking across nylon carpets or separating
plastic transparency films can generate charges of several thousand volts.

Sources of static electricity
There are two sources of static electricity most likely to be encountered by the technician:

• People (especially when wearing clothes made from synthetic fibre)
• Packaging materials such polythene (e.g. bags or tubes), polystyrene containers or padding (e.g.

chipples, etc.) and adhesive tape used to seal containers

Static free workstation
Static sensitive components, including completed circuit boards, should only be used (i.e. inserted or
replaced) at a static free work station. The static free work station will typically include anti-static bench
mats, floor mats and wrist straps and should be kept free from materials which could generate or store a
static charge.
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Working with the CITS
When using the CITS observe the same procedures as when handling static sensitive components:

• U s e  the CITS at an approved anti-static work station.
• Wea r  a wrist strap connected to a suitable earth point. A wrist strap is provided with the CITS

(connect the wrist strap to the stud on the CITS rear panel).
• Other  protective clothing, such as conducting heel straps and metallised coats can be worn if

available.
• Keep materials which may produce static electricity away from the work station.
• Treated completed circuit boards as static sensitive components.
• Avoid dragging the CITS probes across work surfaces.

•

•

•

•
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CITS MACRO REPORT GENERATOR (MRG)

OVERVIEW
The MRG software is an optional accessory for the CITS for WINDOWS and may be ordered as part
number FSW139.

The MRG software, running under Microsoft Excel (version 5.0 minimum), will perform the following
operations on CITS macro test files:

•

•

• Create an Excel file containing a copy of the CITS test results and the associated test files
• Generate statistical data based on the test results
• Produce a Report and/or Summary of the test results (either all data or Passes only)
• Produce an archive copy of the CITS macro results file and clear the original results file ready for

future logging

After the data is imported, it is password protected. Removal of the protection allows modification of the
imported data before printing the report. In addition, when protection is removed, the user is able to make
certain modifications to allow extra statistical calculations, alter terminology, add a company logo, etc. The
user will require knowledge of Excel to be able to make this type of modification.

MRG can accommodate up to 60 tests within the macro and up to 9999 coupons per report.

Installation
To use the MRG software the CITS software must already be installed on the host system. The MRG
software is installed from Microsoft Windows Program Manager:

• From the Program Manager File menu Select Run
• Type  A:INSTALL and press <Enter>
• Follow the instructions on the screen

By default the CITS software will be located in a directory WINCITS in the root directory of the host drive.
The MRG installation routine will offer to create a sub-directory under WINCITS called EXCEL and copy
its files into 1WINCITS1EXCELI. If the CITS has been installed in its default location simply select the
<Continue> button.

If the CITS has been installed in a different directory, it will be necessary to change the path so that the
MRG directory EXCEL is created as a sub-directory of the directory where the CITS software has been
installed.
After installation, an extra icon Macro Report Generator will be added to the Polar CITS program group.

Double clicking on this icon will open Microsoft Excel and the MRG software.

To open both the CITS and MRG software automatically each time Windows is started move or copy the
two icons to Program Manager's StartUp group. (Refer to the Microsoft Windows User Guide for further
information.)
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Setting up your Company template
To open the MRG software either:

• double click on the Macro Report Generator icon or
• w i th  Microsoft Excel running, open the file \WINCITS\EXCEL\CITS.XLS

This will both load CITS.XLS and display the default TEMPLATE.XLS file.

Customising the Summary Sheet
With the TEMPLATE.XLS file displayed, click on the Summary sheet tab to display the Summary sheet.
Any of the text in red in the Summary Sheet may be altered by the user at any time. In this screen the
user can overwrite the red type to enter Company name, address, telephone and fax numbers. After
making the changes save the file under the same name, TEMPLATE.XLS. This file will become the
standard template for all of the future reports generated with the MRG software.

Report Sheet options

Displaying the Minimum and Maximum value columns
Click on the Report sheet tab to display the Report sheet. Use the Show Min and Max Columns Check
Box to display or hide the columns containing the Minimum and Maximum values.
Displaying the Test File Name
The Show Test File Name check box allows the name of the Test File appearing on the Summary sheet
to be added to the column titles.
Changing the column title text
The column title text may be changed from its default value of Test. The column title text is derived from a
hidden named cell Column Title (cell reference A4). Select the Column Title cell via the Name Box and
edit the cell contents as required.

The installation routine also copies a backup copy (TEMPLATE.BAK) of the original TEMPLATE.XLS into
the installation directory (e.g. \WINCITS\EXCEL\).

Should disaster strike (for example if the template file is damaged or corrupted during use, the password
is lost, or modifications are carried out which damage the operation of the software) this read-only backup
file can be opened in Excel, renamed TEMPLATE.XLS and the Company name, etc. added as described
above.

Password Protection
It is possible to make changes to the black text, add a Company logo, alter text fonts, add extra statistical
calculations to the report, etc. if the protection is removed by clicking on Remove Protection and
entering the password.

When the software is shipped, the password is set to "Polar" (note that password recognition is case
sensitive). After the changes are completed and protection installed (click on Install Protection), a new
password may be entered which will be needed for subsequent access to protected areas.

It is strongly recommended that in normal use, the protection is left on to prevent accidental errors. It is
also recommended that a written record of the password is kept in a secure location — without the
password full access to the system is denied.
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MACRO REPORT GENERATOR

To avoid errors the following areas should not be changed:

A number of cells that appear to be blank (i.e. are blank on the display) are used by the software as
named cells — removing or altering any of these names is likely to cause the Reporter software to
produce errors. Named cells are identified by the description in the Name Box — the box on the left
hand side of the formula bar — when the cells are selected. For example, ReportTopLine is a
defined cell name (cell names appear instead of the more usual cell reference, e.g. A8). Do not
make any alterations to cells that are named.

Some calculations are linked — for example 'Cpk' requires 'Min.', 'Max.' and `Std.Dev.' — removal
of any of these three will cause the software to produce a blank field for 'Cpk'.

File management
The following system is recommended for storing Test files and Macro files within CITS:

• Create a directory for each coupon type (named, for example, POL123)
• Store each of the individual track test files in this directory (file names can be used to

indicate details, e.g. 1L5OTA.TST for layer 1, 50 ohm, TOP, trace A)
• Store the macro file for the coupon in this directory giving it the same name as the coupon

type, e.g. POL123.MRF

The CITS is used in the normal way to test coupons using a macro with Autolog selected.

The CITS will automatically log the results in a datafile with the same name as the macro (POL123.CSV
for this example) and the file will be in the same directory as the macro file (POL123 in this example).

When each batch is tested it is suggested that the batch reference number is used as the filename for the
Excel report.

The system described above is not mandatory but is recommended. Its benefit is that one directory
whose name will uniquely identify the coupon will contain all the Test files, the macro file and, eventually,
all of the test results and Reports produced by the Macro Report Generator software for that particular
coupon:

• Test  files (.TST)
• Macro file (.MRF)
• T h e  current datalog file (.CSV) for the coupon
• The  archived datalog file(s) (OLD) for batches processed using the MRG
• The  Excel file(s) (.XLS) for batches processed using the MRG

Using the Macro Report Generator software
When testing is complete, switch to Excel by double-clicking on the MRG icon.

With the Summary sheet of the MRG software displayed clicking on the Load from CITS button opens
the Datalog file for the test just completed. This will be located in the same directory as the macro file
(POL123 in this example).

Note that if the recommended directory system is followed, there will only be one file in the directory that
the software will display as suitable for opening. In this case the user will open POL123.CSV.
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The MRG software will then import:

• A l l  Datalog results
• A  copy of the macro file
• Copies of all the test files used by the macro

A dialog box then prompts for a name for the Report; it defaults to the "Date Code" entered by the
operator during testing (e.g. 9546). The user can either accept this or type in an alternative (up to a
maximum of 8 characters).

The software will then save the Excel file using this name (i.e. creates file 9546.XLS) and re-name the
original CITS Datalog file to 9546.OLD. Both files will be saved in the original macro directory (i.e.
POL123 in this example).

At this stage the user can change any of the red characters on the Report (e.g. a change of operator,
dates, etc.). The black text is password protected.

The imported data and Report can be viewed by clicking on the appropriate tab at the bottom of the
screen.

Two types of Report can be produced by clicking on the Generate Report button:

• A  full Report which contains all of the data (i.e. PASS, FAIL and UNTESTED) or
• A  Report which contains the PASS results only.

In both cases, the Report is sorted by Serial Number of the coupon.

If protection is removed the datalog can be edited.

Selecting Generate Report on the summary screen will regenerate the report using the modified data.

From the Summary page, the user can select the Print button and is offered two options:

• A  full report (i.e. all Test Results and the Summary) or
• Summary only

The user will be prompted to save the file when either closing the file or Excel regardless of whether any
changes have been made. The user should select Yes to ensure that any changes made will be saved.

A report can be viewed and printed at a later date by loading the appropriate file into Excel.

•

•

•
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Customer: Customer name as it appears in the first TEST file used by the Macro
Board Type: Board type as it appears in the first TEST file used by the Macro
Date Code: Date Code as it appears in the first record of the Datalog
Operator: Operator as it appears in the first record of the Datalog
Test Start The date and time of the first record in the Datalog
Test End The date and time of the last record in the Datalog

Test The number of the test in the order specified by the Macro
Test File The filename of the test
Min. Z The minimum allowable impedance for the test obtained from the test file using the

Impedance and Tolerance fields
Max. Z The maximum allowable impedance for the test obtained from the Test file using the

Impedance and Tolerance fields
Method Normal or Average test method as specified in the Test File
Differential On or Off as specified in the Test file
Notes Notes as they appear in the Test file

I

•
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Data imported from CITS
On the Summary sheet, the source of imported data is as below:

General Information

All of the above entries are displayed on the screen and, as they appear in red, may be changed by the
user (if required), before printing and saving.

Test Summary

The above Test Results details cannot be altered in the Summary without entry of the password.
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